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week) with a technology company. Due to visa restrictions, some international students may not be able to participate in this
program.
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This development strategy helps organizations to regularly create and update
their products. Whereas, traditional ‘waterfall’ development model used to take a
lot of time. Today, DevOps is all about the automation and unification of the
development processes.

This DevOps certificate course is focused on providing a comprehensive tour of
the DevOps ecosystem. The student will be able to explore the entire software
development process, which would result in scalability, rapid delivery, security,
and collaboration. We will be designing an application with AWS to make them
scalable and highly available. = N

LSET trainers will be sharing their decades of experience
in DevOps Tools and Training to give you One to One
guidance. You will be working on DevOps tools, Jenkins,
Github, and Sonarqube, Docker to develop Continuous
Integration Continuous Deployment that uses Jenkins,
with sonarqube, Ansible, and docker. It is very important
for the DevOps practitioner to understand the importance
of auto-scaling and high availability and how these
strategies are much better than traditional architecture.

We have also joined hands with relevant IT companies to
provide you with the most updated syllabus according to

the industry standards. This course will be helping IT
practitioners, IT service managers, product owners, test  _
engineers, application or service developers, and i
prolect/test/ process managers.

5 DO DEVOPS ENGINEERS NEED'?

Agile Development: DevOps engineers help teams organize work in shorter iterations,
called sprints, to get through an increased number of releases. They also help map out the
work that teams must complete in upcoming iterations, and incorporate feedback from
each version of a software platform to address future issues.

Continuous Integration (Cl): DevOps engineers make sure that new code coordinates
properly with an existing codebase. It's their job to ensure consistency in development
and avoid the inclusion of components that would hurt performance and negatively affect
users.
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Continuous Delivery (CD): DevOps engineers oversee the continual delivery of new
code via testing and automation. They look for ways to remove waste and ensure that
code is consistently ready-to-deploy. DevOps engineers should understand how to
leverage popular CI/CD tools like Jenkins to manage different aspects of continuous
delivery.

Orchestration: One essential skill often relied upon by
DevOps engineers is being able to analyze current practices
and look for ways to improve efficiency by removing manual
tasks. The orchestration process makes sure any repetitive
steps performed by humans get transformed into an S
automated process to speed up deployments. Such functions
include implementing database changes or launching a new
web server. -

Source / Version Control: Source control tools,
also called version control tools, help DevOps
engineers cut down on development time and
improve their chances of having successful
deployments. These tools facilitate the tracking
and storage of any changes to software projects 4
over different periods. Popular source control tools <
include GitHub, Subversion, AWS CodeCommit,and
Microsoft Team Foundation Server.

Container Management: Containers make it
easier for DevOps engineers to set up hosting of
different applications in a portable environment.
They let you create exact copies of a system
required for deployment. Containers are more
lightweight than the virtual machines used for this
purpose in the past. Examples of popular container
technology include Docker, Kubernetes, Microsoft
Containers, and DigitalOcean. Using containers
helps DevOps engineers ensure consistency
across multiple environments.

\

| w
1

g — 4
- ! \ LR LERS :i"""__ﬁ'.’-:f

e

Programming Knowledge: Having a programming background is crumal to success as
a DevOps engineer. Some languages that a prospective DevOps engineer may want to
learn include Java, Python, PHP, C#, Ruby, G and JavaScript.
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Job Guarantee is an add-on program you can register with this course. You will
need to clear an assessment interview to get enrolled. Once successful in the
assessment, you will be offered Job Guarantee with this certificate course. There is
a fee to join this program as it takes you to rigorous career development, interview
preparation, mock interviews, etc. The fee for joining the Job Guarantee add-on
program is £500. This is a 12 months program which starts at the end of your
certificate course. As part of this program, we represent you to the prospective

employers and train on career development elements...

You need to abide by the rules of this program which you can
find on the Job Guarantee page. If we can't find you a
relevant job or you don't find it by yourself in the similar

industry in any part of the world within these 12 months, we 4 |
will refund you the course fee + Job Guarantee program fee.

The refund process will start after the end of the 12 months
and every month we will pay £500 until the entire fee is paid
back. But if you find a relevant job during this time then the
remaining payments will be stopped. This program is only
applicable to home students (UK permanent residents /
citizens).

LSET offers an optional add-on industry training program to its students. Students
wishing to enrol in this program require to pay fee of £2000 to receive training from
industry experts at IT companies in the US or UK. This is a month-long program which
takes place at the host company'’s location. Interested students need to go through an
assessment and host company’s interview process to be accepted in the program.

COMPLEMENTARY WORKSHOPS
d:

A

GIT MANAGEMENT AGILE PROJECT TEAM BUILDING PERSONALITY

®
/.V’

INTERVIEW

MANAGEMENT DEVELOPMENT PREPARATION
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COURSE INFORMATION

SEPTEMBER JANUARY MAY
END: DECEMBER END: APRIL END: AUGUST

ENTRY CRITERIA COURSE HIGHLIGHTS

@There is no prior understanding @ Hands-on Sessions
needed, but a dev/ops/Linux/network @ Project-based Learning

background will have an edge. @ Live or Offline Capstone Project
o Basic Understanding of English @ Real world development experience
@ Basic Proficiency with Computers @ Industry Mentors

B GHEBTRTTER @ Interactive Teaching Methodologies

EVALUATION CRITERIA

® 18 Coding exercises
® 5 Assignments

& 5 Quizzes

& Capstone Project
@ Group activities

& Presentations

LEARNING OBJECTIVES

@ Install, test, configure, and maintain IT solutions.

& Communicate operational requirements and development forecasts
with everyone in the team.

@ Develop plans and processes for improvement and expansion of the current
technologies being used.
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@ Deploy updates automatically into the production environment using configuration
management software.

& Perform routine application maintenance and troubleshooting measure to ensure the
production environment runs smoothly.

& Perform gap analysis to identify performance enhancements, identify alternative

solutions, and assist with modifications.

s
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COURSE CONTENT

Browse the LSET interactive and practical curriculum
INTRODUCTION

» Course Introduction

» How to make the best of this course
» GIT Introduction and Setup

» Course Induction

» What Is Devops

» History of Devops

» Devops definition

» DevOps Main Objectives

» DevOps and Software Development Life Cycle
» Waterfall Model

» Agile Model

» Continuous Integration & Deployment '

» Jenkins
Containers and Virtual Development

» Docker

» Vagrant

» Configuration Management Tools

» Ansible

» Puppet

» Chef

CLOUD COMPUTING

» What is Cloud?
» Evolution of Cloud Computing
» |AAS (Infrastructure as a Service)
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» SAAS (Software as a Service)
» PAAS (Platform as a Service)
» Private, Public and Hybrid Cloud
» Public Clouds
» Amazon Web Services
» Microsoft Azure
» Google Cloud Services

'LINUX BASIC AND ADMIN

» Linux OS Introduction

» Importance of Linux in DevOps

» Linux Basic Command Utilities
~ Linux Administration

» Environment Variables

» Networking

» Linux Server Installation

» RPM and YUM Installation

SHELL SCRIPTING

» Introduction

» Variables

» Flow Controls

» Loops

» Functions

» Lists

» Manipulating Strings

» Reading and Writing Files
» Positional Parameters

QO +44 (0) 20 3369 9909 ® www.isetuk 8




CONTINUOUS INTEGRATION - JENKINS

» Introduction to Jenkins

» Continuous Integration with Jenkins

» Configure Jenkins

» Jenkins Management

» Scheduling build Jobs

» POLLSCM

» Build Periodically

» Maven Build Scripts

» Support for the GIT version control System
» Different types of Jenkins Jobs

» Jenkins Build Pipe Line

» Parent and Child Builds

» Sequential Builds

» Jenkins Master & Slave Node Configuration
» Jenkins Workspace Management

» Securing Jenkins

» Authentication

» Authorization

» Confidentiality

» Creating Users

» Jenkins Plugins

» Installing Jenkins Plugins
» SCM plugin

» Build and test
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VERSION CONTROL-GIT

» GIT Features

» 3-Tree Architecture

» GIT - Clone /Commit / Push
» GIT Hub Projects

» GIT Hub Management

» GIT Rebase & Merge

» GIT Stash, Reset, Checkout
» GIT Clone, Fetch, Pull

BUILD TOOL- MAVEN

» Maven Installation

» Maven Build requirements

» Maven POM Builds (pom.xml)
» Maven Build Life Cycle

» Maven Local Repository (.m2)
» Maven Global Repository

» Group ID, Artifact ID, Snapshot
» Maven Dependencies

» Maven Plugins

ANSIBLE

» Introduction to Ansible

» Ansible Server Configuration
Infrastructure Management

» SSH Connection in Ansible Master
YAML Scripts

» Host Inventory

X +44(0) 20 3369 9909 & wwwisetuk [Ji0




» Hosts and Groups
» Host Variables

» Group Variables

» Host and Group Specific Data
» Ad-hoc Commands
» Playbooks

» Variables

» Conditionals

» Loops

» Blocks

» Handlers

» Templates

» Modules

» Core Modules

» Extra Modules

» Ansible Roles

DOCKER

» How to get Docker Image?

» What is Docker Image

» Docker Installation

» Working with Docker Containers
» What is Container

» Docker Engine

» Crating Containers with an Image
» Working with Images

» Docker Command Line Interphase
» Docker Compose

» Docker Hub

» Docker Trusted Registry
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» Docker swarm
» Docker attach
> Docker File & Commands

KUBERNETES - AUTOSCALING DOCKER CONTAINERS

» Introduction to Container Orchestration

» Kubernetes Core Concepts

» Understanding Pods

» ReplicaSet and Replication Controller
» Deployments

» DaemonSets

> Rolling Updates and Rollbacks

» Scaling Application

» Services

» Persistent Storage in Kubernetes

» Primitives for PersistentVolumeClaims
- Secrets and ConfigMaps

» Headless Services

» StatefulSets

» Helm Charts

VAGRANT
» Introduction

- Installation and Configuration
» Provisioning with Vagrant
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» Introduction

» About Monitoring tools

» About New Relic

» Installing and Configuring New Relic
» Application Monitoring using New Relic
» Server Monitoring using New Relic

» Alerts policies

AN,

ELK

» Introduction
» Whatis ELK?

» ELK Installation
» ElasticSearch

» Logstash
» Configuring Logstash And Kibana

*Modules of our curriculum are subject to
change. We update our curriculum based
on the new releases of the libraries,
frameworks, Software, etc. Students will be
informed about the final curriculum in the
course induction class.
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ASSESSMENT CRITERIA

To earn the certificate, students must clear all the assessments, quizzes, and project
work. At a minimum, students are required to satisfy the pass criteria of the course.
Students who score 75% or more will be awarded Merit Grade, while students W|th 85%
or more will be awarded, Distinction Grade. >

Following are the detailed criteria for each level
‘Pass Grade Criteria
Score a minimum of 50% aggregate and demonstrate the

following;

Proficiency in the technical skills and
techniques a
~ Must have a minimum attendance €
of 90% in the classes unless
proper medical proof is provided

= Submit all the projects and assignments
before the last submission date

= Collaborate with peers in group projects

Tlyis is to rtifp that

ertificate nf AL['{IBEIPIIIPHt |

Bahriell 1}1111111
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Merit Grade Criteria

Score a minimum of 75% aggregate and demonstrate
the following;

Excellent technical skills and
techniques @ertificate of Achiefiemen
Aith Merit f 4

This is to Uertify that

- Discover and apply strategies to
find the perfect solutions

-Select/design and use appropriate
methods/techniques

Present and communicate
appropriate findings

‘Distinction Grade Criteria
ertificate of Achiefrement Score a minimum 85% aggregate and
W  With Bistinction 2> % demonstrate the following;
B sdid Y@l Mastery of technical skills and
g e S techniques

H pres
institute for t

= Use critical thinking for self-evaluation
and justify valid conclusions

- Take the responsibility the manage
and organise activities and teams

Showcase convergent/lateral/creative
thinking.
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ASSESSMENT METHODS

LSET follows strict uniform standards in assessing students’ performance during the
certificate course. This ensures that the LSET certificate holders demonstrate high ethics
and deep technical knowledge. Internal and external examiners will assess the students,
while the platform will automatically evaluate the quizzes. Instructors are internal
examiners who only assess students’ soft skills. At the same time, the external
examiners are responsible for assessing students’' assessments and project work.

‘Internal Evaluation

Instructors only evaluate students on the following, contributing to 20% of the total
score. The total points that can be earned are 100.

= Punctuality [10 points]: Students are expected to show punctuality with their
attendance, presence, and project/assignment submission time.

~ Dedication [10 points]: LSET expects the students to give attention |
and show dedication throughout the curriculum.,

Time Management [10 points]: Students should show good time
management by completing and submitting their assignments on time.
Time management is crucial for students to prepare for the real work P2
environment. :

= Attendance [10 points]: Minimum of 90% attendance is |
required unless a proper reason with evidence is
provided. Attendance in LSET classes is important to S
ensure that the student has thoroughly learned the “
technical and non-technical concepts taught in the
curriculum.

= Working with Others (Teamwork) [10 points]: LSET
teaches concepts in a collaborative environment where
we expect each student to show teamwork and P= -~ "I°
collaboration skills. i
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~ Problem-Solving Skills [10 points]: Students must demonstrate
proper problem-solving skills. Students need to use the knowledge and
skills gained in the course to solve real-world problems. ~

—Class Participation [10 points]: Engagement and
participation are crucial to ensure the mterac’tlve =
learning experience.

= Communication Skills [10 points]:
Students  should  display  formal
communication skills to communicate with ¢
their teammates. This prepares them for | | e

their future workplace. . R e S

tesporaturs += DayCycle.DaytissMultislier » heatingFactar / sur

~ Presentation Skills [10 points]: Students must
show their presentation skills while working on
their group projects and assignments to become
more presentable.

~ Ability to ask Questions [10 points]: Students should
ask relevant questions in the classes to encourage
healthy discussion on technical topics.

'External Evaluation

External examiners evaluate students on the
following, contributing to 70% of the total
score, The total points that can be earned are
250,

— 5 Assessments [10 points per assessment]: These
assessments are done entirely based on how the
student has performed in understanding the lessons
and concepts taught by the instructor.

= 1Capstone Project [200 points]: The capstone project is conducted
at the end of the certificate course to practice all the practical
concepts. Students must satisfy the criteria mentioned in the project
requirement document to earn full points.
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Auto evaluation will be conducted via the platform, contributing 10% of the total score.
The total points that can be earned are 50

= 5 Quizzes [10 points per quiz]: Quizzes in a class ensure maximum participation and
ensure that the students have learned the taught concepts with attention. Students
will be presented with multiple-choice questions.

Best Career Paths

As a change agent, the DevOps evangelist ensures buy-in from development and
operational teams, identifies the key roles to support DevOps delivery methods, and
makes sure IT professionals are trained and empowered to make those changes, says

Nagisetty. .

A build engineer, sometimes called a build and release engineer
or release engineer, is a computer software engineer who is ¢
focused mainly on developing a line from a program's source
code to a publically available product. In the development of
modern computer applications, code is rarely written from
scratch.

f|p{mr!|§’

Release Manager, in DevOps, is responsible for scheduling, planning, and controlling
the software's development and delivery process. As a Release Manager, you will be
responsible for handling the DevOps team to make them deliver the services on time
and will manage both IT operations and developers.
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Automation Architect ._
An automation architect is a senior-level position that reports to a ClO and is responsible
for aligning automation processes, tools and strategies with business goals.

DevOps Engineer

A DevOps Engineer works with developers and the IT staff

to oversee the code releases, combining an
understanding of both engineering and coding. From
creating and implementing systems software to analyzing *

data to improve existing ones, a DevOps Engineer
increases productivity in the workplace.

Product Manager &y
The Product Manager is responsible for the product planning and execution
throughout the Product Lifecycle, including: gathering and prioritizing
product and customer requirements, defining the product vision, and

working closely with engineering, sales, marketing and support to ensure
revenue and customer satisfaction

Top Companies Hiring Front End Developers

o1 L >

The Course Provides Shared Expertise by
5//LSET TRAINERS 2. INDUSTRY EXPERTS <&t TOP EMPLOYERS

Skills You will Gain

Docker Infrastructure Jenkins

GIT Linux Ansible

Kubernetes Puppet Configuration Management
Web Services Bash Cloud Service Platforms
Good Concept Chef and many more..
Understanding
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Complete Learning Experience

This course provides a hands-on, guided learning experience to help you learn the
fundamentals practically.

We constantly update the curriculum to include the latest releases and features.

We focus on teaching the industry's best practices and standards.

We let you explore the topics through guided hands-on sessions.

We provide industry professional mentor support to every student.

We give you an opportunity to work on real world examples.
Work with hands-on projects and assignments.

We help you build a technical portfolio that you can present to prospective employers.

Reasons to Choose LSET

Interactive live sessions by industry experts.

Practical classes with project-based learning with hands-on activities.
International learning platform to promote collaboration and teamwork.
Most up-to-date course curriculum based on current industry demand.
Gain access to various e-learning resources.

One-to-one attention to ensure maximum participation in the classes.
Lifetime career guidance to get the students employed in good companies.

Free lifetime membership to the LSET Alumni Club
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What Will Be Your Responsibilities?

- Work creatively in a problem-solving environment.
- Ask questions and participate in class discussions.
~ Work on assignments and quizzes promptly.

- Read additional resources on the course topics and ask questions in class.

- Actively participate in team projects and presentations.
L _

-~ Work with the career development department to prepare for interview

Respond promptly to the instructors, student service officers, career development
officers, etc.

~ And most importantly, have fun while learning at LSET. .

How Does Project-Based Learning Work?

LSET project-based learning model allows students to work on real-world applications
and apply their knowledge and skills gained in the course to build high-performing
industry-grade applications. As part of this course, students learn agile project
management concepts, tools, and techniques to work on the assigned project
collaboratively. Each student completes project work individually but is encouraged to
enhance their solution by collaborating with their teammates.

Following are the steps involved in the LSET's project-based learning;
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2

Capstone Project

LSET gives you an opportunity to work on the real world project which will greatly help
you to build your technical portfolio

London has been a leading international financial centre since the 19th century. In
recent years, London has seen many Finllech start-ups and significant innovations in the
banking sector. This project aims to introduce students to the financial industry and
technologies used to handle billions of daily transactions. As part of this project,
students will learn the current technological advances and build up their knowledge to
start a simple banking application. This application uses agile project management
practices to build basic functionality. Students will be presented with user stories to
create the initial project backlog. Students need to enhance this backlog by adding
more relevant user stories and working on them.
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LSET emphasises project-based learning as it allows the students to master the course
content by going through near real-world work experience. LSET projects are carefully
designed to teach the industry-required skills and mindset. It motivates the students
on various essential aspects like learning to work in teams, improving communication
with peers, taking the initiative to look for innovative solutions, enhancing
problem-solving skills, understanding the end user requirements to build user-specific
products, etc.

Capstone Projects build students’ confidence in handling projects and applying their
newly learned skills to solve real-world problems. This allows the students to reflect
upon their learning and find the opportunity to get the most out of the course.

Learning Outcome

»> Students will learn to work in an agile environment

»» Students will learn the agile project management
terms used in the industry, like product backlog, user
stories, story points, epics, etc.

22 Students will learn to use a Git repository and

understand the concepts like commit, pull, push, branch,

»» Students will learn to communicate in a team environment
and effectively express their ideas.

‘Guidance and Help

A dedicated project coordinator who can mentor students on the process will be
assigned to this project. Students can also avail of the instructor’s hours as and when
needed. LSET may get an industry expert with subject-specific experience to help
students understand the industry and its challenges.
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‘Execution Process

This project will be carried out in steps. Each step teaches students a specific aspect
of the subject and development paradigm. Following are the steps students will follow
to complete this project.

Phase 1: Project Introduction Self Study [6 days]

In the first step, students will learn about the financial industry and review the project
introduction documentation to build up the subject knowledge. This is a self-learning
stage; however, instructor hours are available if required.

Phase 2: Project Build-up and Environment Setup [2 days]

In this step, students are required to follow the project guide to set up the development
environment. The project document guides students to find and connect to the LSET Git
repository and install the necessary libraries or tools.

Phase 3: Product Backlog and Sprint Planning [2 days]

In this step, students will use the existing product backlog and enhance it per their
project scope. Students can seek help from the project coordinator and the instructor.
The project coordinator will help students do sprint planning and assign story points
to the stories. This process is meant to give students real-world work environment
experience. Students can consider this a mock exercise on agile project management
practices.

Phase 4: User Stories Execution and Development [12 days]

In this phase, students will work on the user
stories identified in the Phase 3 process.
Students will write code and algorithms to
complete the development objectives. Project
coordinator will be available to help studentsto /"~
guide on the development and answer any €\
questions they may have. Students can also
discuss this with the instructor.
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Phase 5: Testing, Deployment and Completion [5 days]

In this step, students will test and deploy the application to

the cloud environment., Students will experience the
deployment process in the cloud and learn the best
practices. After the successful deployment, students will
present their project to the instructor and the external
project reviewer. Feedback will be given to the students.
Students will have one week to work on the feedback and
submit the final copy of the project, which will be sent to the 4 &
external examiner for evaluation.

Project Presentation

LSET emphasises preparing students for the work environment by allowing them to
learn the required soft skills. After completing the project, students must present their
work to the instructor and an invited project reviewer panel. Please note that the
assigned external examiner will not be part of this panel and hence will not know about
the students. This ensures an unbiased assessment by the external examiner. This
exercise aims to allow students to experience an environment they may face in their
actual job. Also, it gives them a chance to get feedback from industry experts who can
guide students on various parts of the project. This will help students to learn and fix
anything they find necessary in their project. This ensures quality output and allows
students to learn about industry requirements.

The instructor and the project reviewer panel will assess the students on the following;

Project Repository on GitHub [10 points]: The instructor will ensure that the students
have uploaded the project repository to the LSET's GitHub account per the guidelines
in the project requirement documentation. Full points will be awarded if the repository
is appropriately set up per the instructions.

Presentation Skills [20 points]: Students must present their work in the given
timeframe. Full points will be awarded if students cover everything needed to deliver _
their work in the given timeframe.

Communication Skills [20 points]: Students must present their work in a manner
understandable by all the participants. More focus will be given to how students
communicate, not the language. Full points will be awarded if students can share their
work correctly.
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LSET promotes a transparent and unbiased evaluation process. All the external
examiners will follow a set process to grade students. No student’s personal or
identifying information will be shared with the external examiners, so they will not
know about the person they are grading. They will only get the project files and grading
guidelines to follow. This will ensure equal quality standards across the institute.

Following are some critical areas the LSET external examiners will be grading on.

Project Documentation [10 points]: Project
documentation is filed correctly with the information
which can be used to understand the project work.
Students can use the supplied project documentation
template to fill up the data. External examiner to
confirm if all the information is filled up. Full points
will be awarded if all the sections are covered.

Project Structure [10 points]: Students must follow the proper ™\
structure while developing their projects. This structure is being :
taught and covered in the project requirement documentation.
External examiner to confirm if the project files are correctly
structured. Full points will be awarded if the structure meets the
given guideline.

Solves Basic Problem [50 points]: Students must ensure that they implement all the
requirements in the project documentation. External examiner to confirm if the project
solves the given problem. Full points will be awarded if the students include everything
asked in the project requirement.

Innovation [20 points]: Students are encouraged to bring new ideas into their
development. They can improve the design, use new design patterns, code with a better
coding style, or add a feature. External examiner to confirm if the students have added
more than the requirement to improve the design or solution. The new addition must
include a new feature and should not be similar to the requirements given. Full points
will be awarded if the external examiner finds an innovation or see students going
beyond the asked requirements,
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Best Practices [20 points]: Students must follow the best
practices in their development. This will help them to
become a quality resource for their prospective employer.
External examiner to confirm if the supplied best practices _
are followed in the project. Full points will be awarded if the <
best practices are properly implemented.

Performance Consideration [20 points]: Students must

consider performance while working on their projects.
Performance is one of the critical industry requirements. £==
External examiner to confirm if the student thought the /
performance improvements in the project. Full points will be "\,
awarded if the external examiner sees efforts taken to

consider performance aspects in the development.

Security Structure [20 points]: Students need to consider the security aspect If
applicable in the design and development. External examiner to confirm if the security
consideration is appropriate in this project; if it is applicable, the examiner to verify if the
student has considered the security elements in the project. Full points will be awarded
if the external examiner sees efforts taken to assess the security aspect of the
development.

Benefits of LSET Certificate

Earning the LSET Certificate means you have demonstrated
hard-working capabilities and learnt the latest technologies by
completing hands-on exercises and real-world projects.

Following are some of the traits employers can trust you have built
up through your course;

You know how to work in a team environment and communicate well.
You know the tools which are necessary for your desired job.

You know how to use the latest technologies to develop
technologically advanced solutions.

You have developed problem-solving skills to navigate complex
problem scenarios and find the right solutions.

You are now ready to take on the challenge and help your prospective
employer to build the desired solutions.
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What to expect after completing the course?

After earning your certificate from LSET, you can join the LSET's
Alumni club. There are countless benefits associated with the
Alumni Club membership. As a member of LSET Alumni, you can
expect the following;
LSET to hold your hand to find a successful career
. Advice you on choosing the right job based on your passion and goals
Connect you with industry experts for career progression
Provide you opportunities to participate in events to keep yourself updated
Provide you with a chance to contribute to the game-changing open-source projects
Provide you with a platform to shine by allowing you to speak at our events

TOOLS & TECHNOLOGIES YOU WILL LEARN FROM THIS COURSE

&

PUPPET CHEF JENKINS MAVEN DOCKER

REGISTER NOW!
Start Your Journey to becoming a Professional DevOps Engineer

LSET could provide the perfect headstart to start your career in
DevOps Engineer.

t) +44 (0) 20 3369 9909 @ www.Iset.uk
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